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GroupWise 7
Main Window, Mailbox, and Address Book

What is Novell GroupWise?

Novell GroupWise is an integrated mail, calendar, scheduling, and task management software
program. It lets you send and receive mail, appointments, notes, phone messages, and tasks.
Other features of GroupWise include the Calendar, Checklist, Scheduling with Busy Search,
Filtering, and more. GroupWise lets you customize the main window to suit your needs.

The Novell GroupWise Main Window
The GroupWise Main Window is your main work area in GroupWise. Some important parts of

the window are: the Navigation Bar, the Display Options, the Toolbars, the Header, the Folder
List, the Mailbox Item List, the Filter, and more. These parts are explained below.
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- Navigation Bar contains tabs to help you quickly access your most used folders. It can
be toggled on and off from the View menu. Notice the Mailbox tab displays the number
of unread messages in your Mailbox. You can customize the Navigation bar by
right-clicking it to add more tabs or change the color scheme.
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- Display Options buttons are located on the right end of the Navigation bar. There is a
button to display or hide the Folder List, a button to display or hide the QuickViewer, and
a button to display or hide the Main Menu.

- Toolbars allow you to quickly perform common tasks in GroupWise, such as creating a
mail message, viewing your calendar, or viewing the Address Book. You will find the
Main Toolbar plus the Folder Context Toolbar. The options on the context toolbar
change for each selected folder. All toolbars can be toggled on or off under the View
menu. Toolbars can be customized by right-clicking.

- Headers appear above your Folder List, Mailbox Item List, QuickViewer, and in the sent
and received message windows. You can customize headers by right-clicking on them.
After customizing, if you want to return all headers to their default state, right-click any
header and select Reset to Default. Message headers can be copied by right-clicking the
header in a message then selecting Copy Message Header from menu. You can then
paste the copied header into a new message or into a document.

- Folder List appears on the left side of the GroupWise Main Window. It helps you
organize items you send and receive. The Folder List can be toggled on and off using the
button located on the right end of the Navigation Bar. You can add new folders to further
organize items. The default folders are described in the table below.

Folder Contents

Mailbox Displays your received mail items

Sent Items Displays items that you have sent

Calendar Displays your calendar in the main window with several different view options
Contacts Displays your Frequent Contacts from the Address Book
Checklist Displays your “to do” list; you can move any items into this folder
Work in Progress Used to store items that are not yet ready to send

Documents Displays GroupWise documents

Cabinet Storage place for personal and shared folders

Junk Malil Storage place for junk mail messages

Trash Contains items you have deleted

- Mail Item List appears on the right side of the Main Window. It displays items
contained in a selected folder.

- The Filter is located on the right end of the Mailbox Header. You can use the Filter to

select a group of messages to view. You can use the Filter text box to ask GroupWise to
display messages containing almost any character.
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Using the Home View

The Home View shows your most important information. Panels display the information. A
panel is a customized view of information in GroupWise. By default, the Home View displays a
panel containing your calendar for the current day, a panel showing your checklist, and a panel
listing your unread mail items. The following paragraphs explain how you can customize your
Home View.
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Editing and Working with Panels

1. Changing number of panels
displayed. Click the drop-down arrow
at the top right corner of a panel. Click
One Column to view one column of

panels. Click Two Column to view o B -
two columns of panels. Panels are ]
organized in two columns by default. N

2. Adding an existing panel. Click the
drop-down arrow at the top right corner
of a panel. Click Add Panel to display
another panel in your Home View.
Select one of the available panels then click the Add button.

3. Resizing or moving a panel. You can easily resize or move panels with the mouse. To
resize a panel, click and drag a line located between two panels. To move a panel, place
the mouse arrow on panel’s title bar then drag and drop it to a new location.
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4. Closing a panel. Click the drop-down arrow at the top right corner of a panel then select
Close.
5. Editing a panel. If you want to modify other settings for a particular panel, click the

drop-down arrow at the top right corner of the panel then select Edit. You can now
change the panel name, display settings, or the folder or filter associated with the panel.

6. Creating a new panel. Follow the steps below to create a
new panel:
a. Click the drop-down arrow at the top right corner of a | ===
panel. Choce ot odes ok
b. Select Add Panel... il
C. Click New Panel... T ———

d. Type a name for the new panel in the box provided. ' -
e. Choose a folder or an address book. Change display | vl &
settings and add a Filter only if necessary. esbysore |
f. Click OK. Fiter.. | <HoFiten

g

Your new panel should now appear in the list of
available panels. You can select it and click Add to have it appear in your Home
View.
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Understanding Your Mailbox

The GroupWise Mailbox stores both sent and received mail items that you can open, read,
delete, and organize. You can quickly change which items are displayed by clicking a folder in
the folder list or a tab on the Navigation bar. You can use filters to further restrict what items are
displayed.

Bold Items T e e P e — R

Unread items appear in bold text to help you easily see
what has not yet been opened. The icon next to each
item also tells you if an item has been opened or not. §
In the Sent Items folder, items will appear in bold text | =
when they are queued but not yet uploaded, when they
have not been transferred to the Internet, or when
status information has not been received about the : T
item being delivered.

o

Icons Next to Mail Items

Icons that appear next to items in your Mailbox give you information about the item. A table

providing an explanation of what each icon means can be seen by following these steps:

1. Click Help menu then choose Help Topics or press F1.

2. Choose Index tab then type icons in the box under “Type in the keyword to find:”

3. In the topic list, choose “next to incoming items” then click Display button.

4. In the Topics Found box, select “About the Icons Appearing next to Your Items” then
click Display button.

Reading Items

To open an unread mail item, you can do one of the following:

1. Double-click it to view it in a new window.
2. Click the Quick Viewer button on the toolbar. The QuickViewer allows N==E
you to quickly read or scan a list of messages.

(Note: the QuickViewer can be displayed at the bottom or the right by
making desired selection under the View menu, QuickView.)

Replying to Items

=

To reply to a message, click the Reply button on the toolbar.

2. Click OK if you want to send the reply to the original sender
only or select Reply to all if you want to reply to the original
sender plus all the recipients.

3. Check Include message received from sender if you want to include the original

message.
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4. Enter a message.
5. Click Send. The original message will remain in your Mailbox.

Forwarding Items

When you want to send someone a copy of an item, you can forward it to them. The forwarded
item can be sent as an attachment or as part of the message text by selecting the desired option
from the Forward button drop-down list. You access the drop-down list by clicking the small
black triangle located on right of Forward button. The steps below explain how to forward a
message.

1. Open the message you want to forward.

2 Click the Forward button on the toolbar.

3. Enter the name(s) you want to send it to.

4, Enter a message if desired.

5 Click Send.

Sending a Mail Message

1. From the GroupWise Main Window, click the Create New Mail button on the Main
toolbar.

2. Type the recipient’s name in the To field or click the Address Item button on the toolbar

to select from a list of users in an address book. GroupWise uses Name Completion as

you type in the To field. The Name Completion feature searches the address books

looking for entries that match what you are typing.

Type a Subject and Message.

4. Click the Send button.

w

Attaching Files

Eile Edit Wiew Actions Tools Accoupts Window Hell

] ) J G Send -+ 3T Cancel address J|
1. To attach a file to a message, select the Attach a File el | send optons |

button on the toolbar.

Locate the file you want to attach.
Click on the filename to select the file.
Choose OK. The file will be displayed at the bottom of the mail message.
Type your message text and click Send.

ok~ own

Using Send Options

You can make a message high priority, request a reply, delay delivery, and more when you use
Send Options.

1. Before sending a message, click the Send Options tab.

2. Choose the desired options from the window.

3. Click Send.



GroupWise Page 6

Composing Messages in HTML

1. From the GroupWise Main Window, click the Create New Mail button on the Main

toolbar.
2. Choose HTML from the View menu.
3. Use the HTML toolbar buttons to insert pictures, format text, add color, and more.

Sending a Phone Message

1. From the Main Window select File, New, Phone Message.

2. Type the recipient’s name in the To field or click the Address Item button on the toolbar
to select from a list of users in an address book.

3. Complete the phone message fields.

4. Click the Send button.
Deleting Mailbox Items
Delete Mailbox items that are no longer needed. Deleted items will be moved to the Trash folder

unless you select to Delete and Empty which bypasses the Trash folder. Below are ways to
delete an item:

1. If the item is open, click the Delete button on the toolbar.

2. (I)frthe item is closed, select it and press Delete on the keyboard.

3. oCrlick and drag it into the trash.

4. gight-click the item and select Delete or Delete and Empty from the menu.

Tip: You can select multiple items in a list by holding the Ctrl key as you click each item. You
can select a consecutive list of items by clicking the first item, pressing and holding the Shift
key then clicking the last item in the list.

Using the Work in Progress Folder

You can use the Work in Progress folder to store incomplete mail items. Items remain stored in
this folder until you have a chance to finish them. When you send the item, the copy in the
Work in Progress folder will be automatically deleted.

1. You can use one of the following ways to save your unfinished mail item:
a. Click File, Save Draft.

b. Click the Cancel button then select Yes.

C. Press Ctrl+S.

Choose the Work in Progress folder.

Click OK.

4. Close the message. It is stored in the Work in Progress folder.

wn
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5. Later when you’re ready to complete the mail item, click Work in Progress.
6. Double-click the mail item you want to finish.
7. Finish your message then click Send.

Working with Sent Items

When you send a mail item, GroupWise places a copy of it in your Sent Items folder so you can
review, delete, retract, and resend the item. You can also check for delivery information on the
sent item. Click the Sent Items folder to display all of your sent items.

Reviewing an Item

1. Right-click the item you want to review and select Open from the menu.
2. Click the Close button when you finish reviewing the item.

Tracking Items

Properties allows you to check the status of any item
you have sent. For example, you can see when an item was
delivered and when the recipient opened it.

1. Open the item you want to track and click the

Properties tab.

2. Click Close when you finish.

Tip: You can also view properties on items you receive. You can see others who received the
item (except for blind copy recipients) and more.

Resending Items

1. Right-click the item you want to resend or select it and click the Resend button on the
context sensitive Item toolbar.

2. Change the message as you wish.

3. Click Send. You will be asked if you want to retract the original message.

4. Click Yes to retract the original message. (Note: only unopened items and items sent to

other GroupWise users can be retracted).
Retracting Sent Items

Items that have become outdated or sent by mistake can be retracted if the recipient has not yet
opened the item. Following are two options for retracting an item:

1. Select the item you want to retract and click the Retract button on the context sensitive
Item toolbar. If the recipient has not yet opened it, the item will be removed from the
recipient’s mailbox. To confirm that the message was retracted, you can look at its
properties.
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2. The Item toolbar also has a Retract and Delete button that will retract the item plus
delete the copy from your Sent Items folder.

Deleting Sent Items

1. Select the item you want to delete.
2. Click the Delete Sent Item button the Item toolbar.

Using the Cabinet

The Cabinet folder contains folders you create yourself to organize your mail items. You can
organize your mail items any way you like.

Creating a Folder

1. Right-click the Cabinet folder.

2. Select New Folder from the menu. There are 3 types of folders you can create. Personal
folder should be selected. Click Next.

3. Type a name for the folder. Entering a description for the folder is optional. Click Next.

4, Click Finish. Notice that GroupWise automatically alphabetizes the folders in your
Cabinet.

Moving an Item to a Folder

1. Select the item you want to move to a folder.
2. Hold down the left mouse button and drag the item to the folder.
(Note: the folder will be highlighted when your mouse is on top of it).

3. When you release the mouse button, the item has been moved to the folder.

Deleting a Folder 21
Delete options

1. Select the folder you want to delete. [

2. Press Delete on the keyboard. e tobe deed

Feceives o 0 items

3. Select Folder(s) and items and click OK. et 0 o

Posted: 0 itemns

Diraft: 0 itemns
Foldei(z): 1 itemsz
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Setting up a Signature =
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1. Select Tools, Options then double-click Environment.

2. Click the Signature tab.

3. Click the Signature checkbox. m—E
4, Type the information you want to appear at the end of your
m

5.

6.

ail messages in the available text box.
Select "Automatically add" or "Prompt before adding"
Click OK.

Setting up an Archive Directory
GroupWise allows you to store messages on your hard drive in a designated place called an

Archive directory. Before you can store a message in the Archive, you must create it by
following these steps:

Jervioamen - 11
Grwwmsl| Ve File Locorion | Clasrngs | Difindt fctions | Signatan | Appmmarcn

1. Click Tools, Options and double-click Environment. et

2. Click File Location. A

3. Type a path for the Archive directory (examples: c:\your :rr,_jmm ________

username, c:\gwarchive).

4, Click OK then Close to return to the Main Window.

Archiving a Message =

1. Right-click the item you want to archive.

2. From the menu that appears, choose Move to Archive. The item will be removed from

the mailbox and placed in the Archive directory. (Note: you can also Archive mail by
using the Actions menu).

Viewing Archived Messages

You can view your archived messages by clicking File, Open Archive. The Open Archive
option works like a toggle switch to open and close the Archive directory. When you’re finished
looking at mail in the Archive, click File, Open Archive to return to the Main Window.

Cleanup Options

You can set up GroupWise to automatically delete or archive messages by following these steps:

1. Click Tools, Options and double-click Environment.
2. Click Cleanup.
3. Select the cleanup options that you prefer for each type of mail item.

4. Click OK then Close to return to the Main Window.
General Options
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You can turn on or turn off some general features using these steps:

1. Click Tools, Options and double-click Environment.

2. Click General.

3. Select the options you want on such as “ Check spelling before send” or “Launch Notify
as startup.”

4. Click OK to save your selections.

Managing Your Mailbox Size

Quota-based disk space management of GroupWise accounts was implemented in May, 2004 to
allow you to keep mail in your GroupWise mailbox for as long as you wish, provided you do not
exceed your 250 megabyte allotment of disk space. If you do exceed your quota, mail will
continue to be delivered but you will lose the ability to send any new mail until you are within
your quota. The information below will help you manage your Mailbox size.

Checking your Mailbox Size

1. Click Tools, Check Mailbox Size to open the Mailbox Size Storage Information
window that displays a pie chart showing your Current mailbox size and your Maximum
size limit.

2. There is a Mailbox Size button located

agelimit. Dnoe you have excesded the: storage fmit, you will not be able to send new
me of pour existing items.

on the status bar at the bottom of the

GroupWise main window. The button . L Ce=1
shows you the percentage of allotted e {F @

quota that you are currently using. You

can touch the button with your mouse to o e e |
see a box showing Mailbox Limit, Space e |
Used, and Space Available. You can e
also click the button once to open the

Mailbox Size Storage Information
window.

Regaining Space in your Mailbox

When you reach 80% of your quota, GroupWise will give you a warning message. When you
reach or exceed your quota, you will continue to receive email but you will not be able to send
messages. The suggestions below will help you regain space if you have received a warning or
exceeded your limit.

1. Delete mail that you no longer need then empty it from the Trash. Remember that mail
located in Sent Items and all folders in the Folder List are using your allocated space.
2. Archive mail that you want to keep for a long time.

Using Mailbox Size Storage Information Window
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Messages can be deleted and archived easily by using the Mailbox Size Storage Information
window.

1. Click Tools, Check Mailbox Size. View

2. Make a selection under View.  rash

3. By default, items are sorted by size. You can sort in ascending or [
descending order by clicking the Size button. You can sortitemsona | ¢ pesedratitems
different field by clicking another field button. For example, if you
want to delete messages by date, you can click the Date button to sort items by date in
ascending or descending order.

4, Select one item or a group of items then click Archive or Delete button to send items to
the Archive or to the Trash.

Junk Mail Handling

Effective management of junk mail will also help you control your Mailbox size. Junk Mail
Handling located in the Tools menu can help you decide what to do with unwanted mail from the
Internet. Internal mail, mail from a sender in Auburn GroupWise system, cannot be managed
with Junk Mail Handling. The “From” field of an internal mail item shows only the sender’s
name and not an internet address. The steps below provide instructions for enabling Junk Mail
Handling.

Click Tools, Junk Mail Handling.

Under “Junk Mail,” select Enable Junk List.

Under “Blocked Mail,” select Enable Block List.

Click OK to save any changes you make to the Junk Mail Handling settings.

N .

How to Junk or Block a Message

When you receive an unwanted message from the Internet, right-click it, touch Junk Mail with
your mouse arrow, then select one of the following:

1. Junk Sender - to send the message and all
future messages from the address or domain to = e car ctaomesros S
your Junk Mail folder.

[ Subject

2. Block Sender - to send the message and all
future messages from the address or domain to
the Trash folder. e et
or oG

3. Trust Sender - to add the message and all i

Havigate 3

future messages from the address or domain to EEC
your Trust List
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Using the Address Book

The GroupWise Address Book is an information center. It can store names, e-mail addresses,
phone numbers, and more. There are three options for accessing address book information: the
Address Book, the Address Selector, and the Contacts Folder.

e nddesatook =loix
The Address Book Window e
iﬁmz@
Click the Address Book button on the Main toolbar | Z:: i o
to open the GroupWise Address Book window. R g -
The Address Book window contains the Novell §::m ey
GroupWise Address Book, Frequent Contacts, and r frovmd e
your personal address books. Each of these is st
described below: gt ML e
8, sbeman s soemuEadumeds  [SIBABID TES [1
:3' ety Jamn e b sl 331|&1|;-1u:n RESERF

- The Novell GroupWise Address Book is
also called the GroupWise System Address Book. It contains all GroupWise users in
your system. This book is maintained by the GroupWise administrator. Contacts,
resources, and public groups can be found in it.

- The Frequent Contacts book stores e-mail addresses of people you have previously
mailed. When you send a message, GroupWise automatically records the e-mail address
in Frequent Contacts. Even though Frequent Contacts is created by GroupWise, it is
considered a personal book since you can add and remove names from it.

- Personal Address Books store addresses that you enter. Your personal address books
can contain individual contacts and groups. You can create as many personal address
books as you wish to help you organize your e-mail contacts. Personal address books can
be shared. By default, you have a personal address book named after you.

Selecting Columns to Display

You can decide what columns or fields of information you want displayed in each of your
address books. Each address book can have different columns displayed.

1. Open the Address Book by clicking the button  svisesan Sekcod o
on the Main toolbar. I — st =T
2. Select the address book in which you want to e :ﬁ e
change the displayed columns. E
3. Right-click a column heading and select More [ ovmnein
Columns from the menu. i prmpssin
4. Use the Add and Remove buttons to place the ~ i&" - @
columns you want under Selected columns. T e e b | |
Name
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5. You can order the columns you select by clicking the Down and Up buttons.
6. You can select the size each column button by clicking the Smaller and Larger buttons.
7. Click OK when you’re finished.

Sorting an Address Book

Address books are sorted on the Name field by default. If you want to change that sort order, use

the steps below:

1. Open the Address Book by clicking the button on the Main toolbar.

2. Select the address book you want to sort.

3. Right-click the column you want to sort on.

4 Select Sort All Ascending or Sort All Descending or Sort on ‘Field name’ First from
the menu. (Note: the column you are sorting on will be underlined).

Creating a New Personal Address Book

1. Open the Address Book by clicking the button on the Main toolbar.

2. Click File, New Book. 2

3. Enter a name for the new book. [ = 1

4. Click OK. A new address book will appear in your list. ' o |

Adding Contacts to a Personal Address Book

1. Select the personal address book that you want to add a contact name to.

2. Click the New button on the toolbar, select Contact and click OK.

3. Enter the information you want to store. It’s not mandatory to fill all of the fields with
information. Most important is the First name, Last name, Display name, and Email
address. Click OK when you’re done.

4, To edit a contact, double-click the name, select Contact tab, make your changes then
click OK.

5. To delete a name from an address book, click it and press Delete key on the keyboard or

right-click it and select Delete from the menu.
Copying Addresses from One Book to Another

Open the Address Book by clicking the button on the Main toolbar.

Select the address book you want to copy address(es) from.

Highlight the name(s) you want to copy.

Click and drag the name(s) to the address book you want to copy to.

OR

5. Right-click the highlighted name(s) and select Copy To... from the menu, select the
address book you want to copy the address(es) to then click OK.

APwbhpE
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Using the Address Book Window to Send a Message

1. Open the Address Book by clicking the button on the Main toolbar.

2. Select an address book then click the name(s) you want to send the message to.

3. Click the Action button drop-down list on the toolbar and select Send Mail (or Send
Appointment or Send Note or Send Task).

4. Complete your message and click Send.

Setting up Name Completion Search Order

As you type a person’s name in the To box of an item window, GroupWise’s name completion
feature searches your address books to find the person you want to send the message to. When
GroupWise finds the correct name, you can stop typing. You can help GroupWise locate the
name faster by customizing Name Completion Search Order.

Follow these steps to set up Name Completion Search Order:

1. Open the Address Book by clicking the button on the Main toolbar.

2. Click File, Name Completion Search Order...  mmmmmmm—m—mm =5
3. GroupWise searches the address books listed sl ok ettt
under Selected books. The books are searched in o A

the order they are listed.

4. Highlight an address book under Selected books
and click the Remove button to take it out of the
search order list. B

5. Highlight an address book under Available books [ ekt _ |
and click the Add button to add a book to the T e e e v B e STk T
search order list.

6. The Up and Down buttons can be used to change a book’s position in the search order
list. Click OK to save your selections.

N [ L

Tip: Since the "Frequent Contacts' address book stores all e-mail addresses that are typed in a
'To’ box including misspelled addresses, consider leaving Frequent Contacts out of your
Name Completion search order list.

Creating Groups from the Address Book Window

There are several methods one can use to create a group or mailing list. The steps below show
you how to create a group using the Address Book Window:

1. Open the Address Book by clicking the button on the Main toolbar.

2. Highlight the address book in which you want to save the group
you are creating.

3. Click the New button.

4, Select Group for the entry type and click OK.

Jrew Entry 21
Select the entiy lppe:
ancel
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5.

6.
7.

10.

11.
12.

Type a name for your group then enter comments describing the
group if you wish. e P :
Click the Add button. 0 — o
You can select names from any of your address books to include | 2=« | '
in your group. If you need to include a name that is not already
in one of your address books, you can click New Contacts to add
someone to the selected address book.

Double-click the names you want placed in the To box. These
will be the primary recipients in your group. You can also click
and drag names on top of the To button to select them for your
group.

If you want to carbon copy (CC) some group members, you can
click the CC button then double-click the names you want or
click and drag names on top of the CC button.

If you want to blind copy (BC) some group members, you can
click the BC button then double-click the names you want or
click and drag names on top of the BC button.

After selecting group members, click OK to return to the New Group window.
Click OK to save the group.

Editing a Group using the Address Book Window

=

Open the Address Book by clicking the button on the Main toolbar.

Select the address book that contains the group you want to edit. If necessary, click the
plus sign to display the groups inside the selected address book.

Click on the group you want to edit to make the names appear on the right side of the
window.

Delete a name by right-clicking it then selecting Delete from the menu or by pressing the
Delete key on the keyboard.

To add a new member, you must right-click the group’s name, choose Details then click
the Add button.

Select the names you want then click OK twice to save the changes and return to the
Address Book window.
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Using the Address Selector

: 21
. Look in: NuveHEruuleseAddlasanuk ﬂ [ I _IQ': _IEE
The Address Selector provides you Lok | e R i~
with a simplified view of the S
GroupWise Address Book. It can be 3 e Semieaban o
opened from a Mail To: window while |3 «..
composing a new message. Click the | |3 i rmmmse  comtmmnms
Address Item button on the toolbar to | [3 Seweras N
- a 4-H and Vouth Development ACES cesdhyd@: Leduy
open it. You can select a name(s) or ol oo,
- A McKenzie Davenport davenam@auburn, edu
create a group in the Address Selector. | |2 ~imiim
8 A Seottedward Hodel hodelas@auburn, edy
TO Change the bOOk yOU Want tO See, 2 AT Fromhoid fromhataauburn.edu =l
- - - B tevsorteer [ Bl B SaveGioun - 3 Reove
click the Look m_drop-down list and
make your selection. 4

Selecting Names with the Address Selector

1. Click the New Mail button on the Main Window toolbar.

2. In the Mail To: window, click the Address Item button on the toolbar.

3. Double-click the names you want placed in the To box. These are your primary
recipients. You can also click and drag names on top of the To button to select them.

4. If you want to carbon copy (CC) anyone, you can click the CC button then double-click
the names you want or click and drag names on top of the CC button.

5. If you want to blind copy (BC) anyone, you can click the BC button then double-click

the names you want or click and drag names on top of the BC button.
6. Click OK to close the Address Selector.
7. Compose your message and click Send.

Creating Groups with the Address Selector
Use the steps below to create a group with the Address Selector:

Click the New Mail button on the Main Window toolbar.

In the Mail To: window, click the Address Item button on the toolbar.

Select an address book containing people you want to include in your group.

Double-click the name of each person you want in your group. You can select names

from any of your address books.

5. If you want to carbon copy (CC) anyone, you can click the CC button and then double-
click the names you want to carbon copy.

6. If you want to blind copy (BC) anyone, you can click the BC button and then double-
click the names you want to blind copy.

7. If you want to add a person that is not in one of your address books, click the New
Contact button, enter the needed information, click OK then double-click the new name
to add it to the group.

8. After selecting all the people you want in your group, click the small triangle on the

Save Group button and select the address book in which you want to store your group.

ApoppE
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9.

10.

Type a name for your group. Enter comments describing the group if you wish then click
OK to save the group.
Close the Address Selector.

Editing Groups with the Address Selector

AopE

In a Mail To: window, click the Address Item button on the toolbar.

Open the address book that contains the group you want to edit.

Right-click the group’s name and select Edit Group from the menu.

Delete a name by right-clicking it then selecting Remove from the menu or by pressing
the Delete key on the keyboard.

To add a name, click the Add button. Double-click names from any of your address
books to add them to your group. Click OK when you finish adding names.

Click OK to save the changes to your group then close the Address Selector.

One More Way to Create a Group

Open a Mail To: window.

Type names of people that you want to be in your group in the “To:” box and in the “CC”
and “BC” boxes if you wish.

Click the Address Item button on the toolbar to open the Address Selector.

Click the small triangle on the Save Group button and select the address book in which
you want to store your group.

Type a name for your group. Enter comments describing the group if you wish then click
OK to save the group.

Close the Address Selector.



